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ВВЕДЕНИЕ  

Лень – двигатель прогресса. С тех пор как появилась математика, 
люди мечтали о неких «универсальных вычислителях», которые 
вместо них складывали бы 2 + 2, считали криволинейные интегралы 

и делали преобразование Фурье. Мечта эта сбылась лишь в ХХ веке 
с появлением ЭВМ, и, как водится, результат превзошел ожидания. 

Впечатляют не только вычислительные мощности современных 

компьютеров, но и глобальная сеть Интернет, дающая практически 

неограниченные возможности для коммуникации и поиска инфор-

мации. 

Для чего же его использует большинство пользователей? В каче-
стве дорогой игрушки или (в лучшем случае) пишущей машинки. 

Почему? Да просто потому, что немногие знают всей мощи совре-
менных пакетов для научных расчетов. Курс ТВС даст Вам, ува-
жаемый читатель, возможность узнать, насколько хороший компь-

ютер может облегчить жизнь химика. 
Но прежде чем Вы начнете листать это пособие и разбираться с 

хитростями программ, предлагаю прочесть ответы на основные во-

просы, которые могут возникнуть у Вас в ходе работы. 

 

Частые вопросы и ответы (ЧаВО) 

She had read several nice little histories about children 

who had got burnt, and eaten up by wild beasts and other un-

pleasant things, all because they would not remember the 

simple rules their friends had taught them. 

Lewis Carroll 

Что такое ТВС? 

«ТВС» расшифровывается как «терминальная вычислительная 

система» − термин, сохранившийся со времен больших ЭВМ, с ко-

торыми студенты НГУ «общались» с помощью терминалов – ви-

деодисплеев, оснащенных клавиатурой. Многим импонирует аль-

тернативное толкование: «творческое время студента».  Последнее 
определение делает понятной цель этого курса: выработку само-

стоятельных творческих навыков обращения с математическими 

программами и химическими базами данных. Студентам предлага-
ются три задания: дифференциальное уравнение (система диффе-
ренциальных уравнений); сложное уравнение (система уравнений) и 
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поиск информации. Первые два задания подобраны так, что проще 
и точнее всего решить их численно, информацию по третьему зада-
нию удобнее всего искать в сети Интернет. 

 

Как решать задачи? 

Для численного решения Вы можете использовать любые про-

граммы: Microsoft Excel, Borland Delphi, Fortran, Matlab, Mathe-

matica, Maple и т. п., но мы рекомендуем использовать MathSoft 

Mathcad® − программу, максимально адаптированную для решения 

Ваших задач и обладающую интуитивно понятным интерфейсом. 

 

Где искать информацию? 

К Вашим услугам весь Интернет. Поисковые сайты общего ха-
рактера: www.ya.ru, www.google.com, www.yahoo.com. Химические 
базы статей: www.elibrary.ru, www.sciencedirect.com. Патентные ба-
зы данных: www.uspto.gov, gb.espacenet.com, www.fips.ru. Химиче-
ский сайт общей направленности: www.chemweb.com. Естественно, 

вас никто не ограничивает этими сайтами. 

 

У меня дома есть компьютер. Нужно ли ходить на занятия? 

Даже если у Вас есть дома компьютер, и вы предпочитаете вы-

полнять задание дома, посещение семинаров хотя бы раз в 2 недели 

является обязательным. На семинарах преподаватель будет видеть 

Ваш прогресс, сможет подсказать решение проблемы, да и просто 

ему приятно видеть умных людей. 

 

У меня дома все работало, а тут не запускается! 

Если у Вас дома установлены программы более поздней версии, 

нежели в терминальном классе, то обязательно сохраняйте свою ра-
боту в таком формате, чтобы Вы могли ее открыть в классе. Слова 
«у меня дома все работало, а тут, наверное, софт старый» не счита-
ются оправданием, и работа не принимается. 

 

А у меня программа ругается и не считает! 

Рекомендуем следующую последовательность действий: 

Успокойтесь и поймите, что машина тупа и считает лишь то, что 

Вы ей даете. 
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Проверьте, не допустили ли Вы синтаксических ошибок при за-
писи выражений, везде ли Вы правильно используете нужные типы 

данных (например, не подставили ли в выражение вместо векторной 

переменной скалярную величину). Попробуйте разобраться, что же 
она (программа) Вам пытается сказать. 

Нажмите клавишу F1. Математические программы снабжены 

обширным справочным руководством и файлами примеров, кото-

рых хватает для разрешения любой проблемы. Выберете закладку 

«Указатель (Index)» и введите ключевые слова описания проблемы. 

Позовите преподавателя или проконсультируйтесь с соседями. 

 

А тут все по-английски! Как будет по-английски «дифур»? 

В данном случае - Differential Equation. А вообще для перевода 
существуют сайты lingvo.yandex.ru, www.multitran.ru/c/m.exe,  

www.hyperdictionary.com/dictionary, www.thefreedictionary.com и 

множество им подобных. 

 

Что запрещается на занятиях? 

Запрещено следующее: 
• Входить в терминальный класс в верхней одежде или класть ее 

на стулья/столы. Посещение гардероба отнимет у вас не более 10 

минут времени. 

• Приносить на занятия еду/напитки. Нам не нужна пролитая на 
клавиатуру газировка. 

• Устанавливать какие бы то ни было программы, даже на время 

занятия. 

• Посещать сайты с сомнительным содержанием (бесплатные ау-

дио/видео коллекции, хакерские сайты, порносайты). Бесплат-
ным бывает только сыр в мышеловке, и за лечение компьютера 
от вирусов Вы заплатите из своего кармана. 

• Заходить в сеть иначе как под своим именем и паролем. 

• Совершать иные действия, могущие нанести ущерб НГУ. 

 

Я уже все сделал(а). Что делать дальше? 

Наши поздравления! Вы можете распоряжаться временем заня-

тий по своему усмотрению: попросить задания повышенной слож-

ности у преподавателя, сидеть в Интернете, осваивать программы 

или просто идти домой и готовиться к очередной контрольной. 
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1. ВВЕДЕНИЕ В ЧИСЛЕННЫЕ МЕТОДЫ  

…and then the different branches of 

Arithmetic – Ambition, Distraction, Ug-

lification, and Derision. 

Lewis Carroll 

В данном разделе собрана необходимая информация об основ-

ных численных методах, реализуемых на компьютере. Формулы 

приводятся для общего ознакомления, без вывода, акцент делается 

на понимание сущности метода. Для пользователя программы, как 

правило, не важно, как была получена та или иная формула, гораздо 

важнее знать границы ее применимости. Желающие ознакомиться с 
конкретным методом подробнее могут обратиться к соответствую-

щим учебникам (см. библиографию).  

 

1.1. Линейная регрессия и метод наименьших квадратов 

Многие эксперименты представляют собой определение некой 

нормально распределенной величины Y как функции от независи-

мой переменной Х, контролируемой с большой точностью. Это мо-

жет быть зависимость рН от объема добавленного титранта, кон-

центрации реагента от времени, давления насыщенного пара от 
температуры, и так далее. Нахождение функциональной зависимо-

сти y = f(x), наиболее точно описывающей набор табличных значе-
ний (Yi,Xi) называют аппроксимацией, или регрессией. 

Часто между переменными X и Y стараются найти линейную за-
висимость и найти «оптимальную» линию регрессии вида 

baXY += . 

Данная «оптимальная» линия должна характеризоваться сле-
дующим свойством: сумма квадратов отклонений рассчитанных 

значений Y, взятых по этой линии, от экспериментальных значений 

должна быть минимальна. Это и есть метод наименьших квадратов, 

реализуемый в математических программах. 

Коэффициенты а и b можно определить по следующим форму-

лам, приводимым здесь без вывода: 



 7

( )( )

( )

( )( ) ( )( )

( )∑ ∑
∑∑∑∑

∑ ∑
∑∑∑

−

−
=

−

−
=

22

2

22

ii

iiiii

ii

iiii

XXN

YXXXY
b

XXN

YXYXN
a

  

Здесь Yi – экспериментальное значение Y, соответствующее Xi, N 

– число точек измерения. 

 

1.2. Итерационное решение нелинейных уравнений 

Рассмотрим уравнение ( ) 0=xf . Его истинным решением будет 

такое значение x , что ( ) 0=xf . Рассмотрим, как можно найти 

численными методами приближенный корень x~  с точностью ε, т. е 

ε<− xx ~ . 

Решение задачи методом бисекции разбивается на два этапа: ло-

кализация и итерационное уточнение корней. На первом этапе на-
ходится отрезок [a, b], содержащий один и только один корень 

уравнения ( ) 0=xf . На краях отрезка функция ( )xf  имеет разные 

знаки: ( ) ( ) 0<⋅ bfaf . 

На втором этапе делим отрезок [a, b] пополам точкой с. Если 

( ) 0=cf , то задача решена, если нет, то выбираем из двух полу-

чившихся отрезков [a, c] и [b, c] тот, на краях которого функция 

имеет разные знаки, и повторяем итерацию еще раз. 
Последовательность итераций считается законченной на шаге i, 

если длина отрезка [ai, bi] < 2ε. В этом случае корнем x~ , найденным 

с точностью ε, является середина отрезка [ai, bi] – точка сi. 

Метод Ньютона (метод касательных) заключается в том, что 

следующим приближением 1
~

+ix  к истинному корню x  уравнения 

( ) 0=xf  считается точка пересечения с осью абсцисс касательной, 

проведенной к функции ( )xf  в точке ( )( )ii xfx ~,~ . Расчетная формула 
имеет вид  

( )
( )i

iii

xf

xf
xx

~'

~
~~ 1

−=
+ . 
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Критерий окончания итераций считается исходя из скорости из-
менения производной в окрестности x , но для простоты может 
быть оценен как шаг, на котором ε<− +1

~~
ii

xx . 

Слабое место обоих методов состоит в том, что сначала требует-
ся оценка границ области значений x, в которой лежит единствен-

ный интересующий нас корень. При наличии нескольких корней 

(например, для уравнения 2ln(x)=x-2) компьютер может выбрать не 
ту область и выдать ответ, лишенный физического смысла. Оценить 

правильность полученного результата способен только человек. 

 

1.3. Решение дифференциальных уравнений 

Химику часто приходится иметь дело с процессами, параметры 

которых непрерывно меняются в зависимости от некоторой пере-
менной. Эти явления обычно подчиняются законам, которые фор-

мулируются в виде дифференциальных уравнений ( ) ( )yxfxy ,' = . 

Одной из основных математических задач, которые приходится ре-
шать для таких уравнений, является задача Коши (или начальная 

задача). Эта задача возникает тогда, когда начальное состояние сис-
темы в точке x0 считается известным (y(x0)=y0) и требуется опреде-
лить ее поведение при x ≠ x0.  

В тех случаях когда невозможно найти аналитическое выраже-
ние ( )xy  (часто так и происходит), применяют численные методы. 

В основе их построения лежит тот или иной способ замены диффе-
ренциального уравнения ( ) ( )yxfxy ,' =  его дискретным аналогом. 

Простейшим и исторически первым численным методом реше-
ния задачи Коши является метод Эйлера. В его основе лежит идея 

графического построения решения дифференциального уравнения. 

Этот метод дает одновременно и способ нахождения искомой 

функции в численной (табличной) форме. 
Идея метода заключается в том, что промежуток [a, b] разбива-

ется на конечное число n интервалов длиной h точками x1, x2,… xn, и 

площадь под кривой производной представляется в виде суммы 

площадей прямоугольников ( )∑ ⋅ hxy i' . Таким образом, на малом 

промежутке h изменения независимой переменной 
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1+=+≤≤ iii xhxxx  вместо интегральной кривой дифференциаль-

ного уравнения ( )xy  берется касательная к ней  

( ) hyxfyy iiii ⋅+=+ ,1 . 

В результате неизвест-
ная интегральная кривая 

заменяется приближенной 

к ней ломаной линией 

(ломаной Эйлера), для ко-

торой угловой коэффици-

ент n-го звена равен 

f(xn,yn) (рис. 1). 

Метод Эйлера обладает 
невысокой точностью, 

имея лишь первый поря-

док аппроксимации: с из-
менением h ошибка вы-

числений также меняется 

пропорционально h. К то-

му же погрешность каж-

дого нового шага, вообще 
говоря, систематически 

возрастает. Наиболее при-

емлемым для практики 

методом оценки точности является в данном случае метод двойного 

счета – с шагом h и шагом h/2. Совпадение полученных двумя спо-

собами результатов дает естественные основания считать их вер-

ными.  

Гораздо более точным является метод Рунге−Кутты. Формулы 

для наиболее популярного алгоритма четвертого порядка приводят-
ся здесь без вывода: 









++++=+

2
2

3

1 4
3211

k
kkkyy ii , 

где коэффициенты k вычисляются как 

 
Рис. 1. Графическая интерпрета-

ция метода Эйлера (по материалам 

сайта www.exponenta.ru) 
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Для повышения точности расчета иногда применяется метод 

Рунге−Кутты с переменным шагом. В этом случае интервал разби-

вается на участки разной длины: там, где решение меняется слабо, 

шаги выбираются редкими, а в областях его сильных изменений – 

частыми. Это очень просто осуществить, так как алгоритм Рун-

ге−Кутты является одношаговым и подразумевает простой пересчет 
при любом значении шага hi искомого y(xi+hi) через y(xi). В резуль-

тате применения адаптированного алгоритма для достижения оди-

наковой точности может потребоваться существенно меньшее чис-
ло шагов, чем для стандартного метода Рунге−Кутты с фиксирован-

ным шагом. 

Несмотря на кажущуюся универсальность, метод Рунге−Кутты 

«не работает» в случае так называемых жестких дифференциальных 

уравнений и соответствующих систем. Будьте осторожны в выборе 
метода, когда решаете, например, уравнение вида 

( ) ( ) ( )xxyxy sin25cos25' ++−= , ( ) 10 =y , или анализируете кинети-

ческую схему с сильно различающимися константами скорости, ти-

пичную для автокатализа и – особенно! – автоколебаний! Если вме-
сто красивых кинетических кривых метод Рунге−Кутты выдает не-
понятные осцилляции, знайте: Вы столкнулись со случаем жесткой 

системы. Для решения требуется применение совсем иных алго-

ритмов, например неявных методов типа метода Булирша−Штера. 

Основной идеей метода является вычисление состояния системы 

в точке x+h как результата двух шагов длины h/2, четырех шагов 

длины h/4, восьми шагов длины h/8 и так далее с последующей экс-
траполяцией результатов. Метод строит рациональную интерполи-

рующую функцию, которая в точке h/2 проходит через состояние 
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системы после двух таких шагов, в точке h/4 проходит через со-

стояние системы после четырех таких шагов, и т. д., а затем вычис-
ляет значение этой функции в точке h = 0, проводя экстраполяцию. 

Таким образом, проводится один шаг метода, после чего принима-
ется решение, следует ли изменять шаг, а если да, то в какую сторо-

ну. При этом используется оценка погрешности, которую мы полу-

чаем в качестве дополнительного результата при рациональной экс-
траполяции. 

 

1.4. Гармонический анализ и ряд Фурье 

Применение преобразования Фурье произвело настоящий пере-
ворот в спектроскопии. Стало возможным регистрировать и обраба-
тывать ЯМР-, ИК- и УФ-спектры за несколько секунд или даже до-

лей секунд, обеспечивая быстрый перевод первичного сигнала к 

привычному виду (рис. 2). Конструкция приборов упростилась, а 
круг возможностей спектральных инструментов зачастую опреде-
ляется вычислительной мощностью компьютера. 

 

 
Рис. 2. Сигнал спада свободной индукции а и полученный из не-
го спектр ЯМР б. Рисунок любезно предоставлен К.П. Брыляко-

вым   

 

Смысл преобразования Фурье заключается в представлении 

функции в виде суммы периодических функций (синусоид). Основ-
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ное применение преобразования Фурье в химии – перевод функции 

от времени в функцию от частоты: 

( ) ( )∫= dtetff
tiωω . 

Теорема Фурье гласит, что любую зависящую от времени функ-

цию можно представить в виде суммы синусов и косинусов с соот-
ветствующими весами (амплитудами). Таким образом, из общего 

«хора» сигналов преобразование Фурье выделяет отдельные «голо-

са», определяет их частоту и амплитуду. 

Для численных расчетов был разработан быстрый и эффектив-

ный метод быстрого преобразования Фурье (БФП, в англоязычной 

литературе FFT − Fast Fourier Transform,), включенный во все серь-

езные математические программы. Смысл БФП заключается в раз-
биении массива точек на два подмассива и проведении преобразо-

вания Фурье над каждым в отдельности. Единственным ограниче-
нием БПФ является то, что длина набора данных должна быть равна 
целой степени двойки (т. е. можно обработать 512 точек, но не 511 

или 513).  
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2. ОБЩИЕ ПРИНЦИПЫ РАБОТЫ С ПАКЕТОМ 

MATHSOFT MATHCAD 

 

Система Mathcad компании Mathsoft уже довольно длительное 
время является бесспорным лидером среди математического ПО с 
WYSIWYG (what you see is what you get) интерфейсом, максималь-

но приближающим внешний вид документов к традиционным рас-
четам «на бумаге». Язык ввода формул прост и понятен интуитив-

но, однако для облегчения Вашей работы в этом разделе рассмотре-
ны некоторые особенности программы и правила общения с ней. 

 

2.1. Общий вид 

– Begin at the beginning, – the King 

said gravely, – and go on till you come 

to the end: then stop. 

Lewis Carroll 

Итак, Вы запустили программу Mathcad и видите перед собой 

следующую картину (рис. 3) 

Общий интерфейс традиционный и очень похожий на стандарт-
ные офисные программы. Сверху находятся кнопки меню File, Edit  

Рис. 3. Общий вид окна Mathcad 
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etc., чуть ниже - строчки пиктограмм. Панели можно скрыть и вы-

звать в меню “View > Toolbars”. Отличие от Microsoft Word, пожа-
луй, только в том, что вместо обычного мерцающего курсора в поле 
документа находится красный крестик, отмечающий место ввода. 
Кликом мышки Вы можете переставлять этот крестик в любое ме-
сто документа. 

По умолчанию формулы и текстовые комментарии вводятся раз-
ным шрифтом. Попробуйте ввести выражение «Mathcad is a math 

program» (без кавычек). Заметили особенность? Как только Вы вво-

дите пробел, шрифт изменяется, и система воспринимает введенное 
выражение как текст. Помните об этом! 

 

2.2. Mathcad как калькулятор 

– Four times five is twelve, and four 

times six is thirteen, and four times 

seven is – oh dear! I shall never get to 

twenty at that rate! 

Lewis Carroll 

Поначалу система Mathcad позиционировалась разработчиками 

как суперкалькулятор. Попробуем посчитать какое-нибудь выраже-
ние, например, оценить константу равновесия для реакции паровой 

конверсии СО (∆H = –41,17 Дж/моль, ∆S = –42,09 Дж/моль*К) при 

температуре 600 K. Энтальпию и энтропию сорбции в первом при-

ближении можно считать не зависящими от температуры. 

Введите следующее выражение: 
exp(-(-41170+42.09*600)/600*8.314)= 

На экране появится сле-
дующее выражение (рис. 4). 

Как видите, форма записи 

максимально приближена к 

вычислениям «на бумаге». 

Рекомендуем потрениро-

ваться во вводе различных выражений самостоятельно. 

Если после нажатия клавиши “=” компьютер не вычисляет зна-
чение автоматически, поставьте галочку “Automatic calculation” в 

меню “Tools > Calculate”. 

 
Рис. 4. Вычисления в Mathcad 
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Численный ответ выдается в виде десятичной дроби, с тремя 

знаками после запятой. Эти параметры можно изменить в меню 

“Format > Result”. Попробуйте, например, представить ответ в виде 
натуральной дроби (Fraction). 

Несмотря на то что ядро Mathcad предназначен для численного 

решения, он позволяет также производить и несложные символьные 
расчеты. Например, брать неопределенные интегралы типа интегра-
ла зависимости теплоемкости от температуры a+bT+c/T

2
. Для этого 

ведите знак неопределенного интеграла (Ctrl+I либо с панели “Cal-

culus”), запишите уравнение и поставьте после него вместо обычно-

го знака равенства значок символьного решения “→” (Ctrl+. либо с 
панели “Evaluation”). 

 

2.3. Операторы присвоения 

– When I use a word, – Humpty 

Dumpty said in rather a scornful tone, – 

it means just what I choose it to mean – 

neither more nor less. 

Lewis Carroll 

Естественно, было бы много удобнее записать уравнение в пара-
метрическом виде и, меняя значение параметров, получать разные 
ответы. Например, записав один раз формулу 








 ∆−∆
−=

RT

STH
K p exp  и меняя значения Т, можно получить значе-

ния Кр при разной температуре. 
Для этого сначала научимся определять переменные.  
Важно! Никогда не путайте операторы присвоения (:=), глобаль-

ного присвоения (≡), вычисления ответа (=) и булева равенства (====). 

Оператор присвоения (:=) вводится нажатием двоеточия “:” ли-

бо, если переменная не используется системой, нажатием знака ра-
венства “=”. Так, набрав е= , автоматически получите ответ 

 (число е является системной переменной). В то же время, 

набрав е: , получите  и можете сами определить значение 
данной переменной. 
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Оператор присвоения определяет переменную только для расче-
тов, идущих ниже. Если требуется определить переменную для ис-
пользования во всем документе, используйте оператор глобального 

присвоения (≡), вызываемый нажатием “~” (тильда).  
Оператор вычисления ответа (=) служит для вызова значения пе-

ременной или выражения и вводится знаком равенства “=”. 

Оператор булева равенства (====) используется, например, при по-

иске корней уравнения в блоке решения “given – find” (подробнее в 

главе 2.4). 

Теперь, разобравшись с особенностями определения перемен-

ных, попробуйте ввести следующие выражения (рис. 5). Здесь под-

строчный символ для Кр 

вводится нажатием точки 

“.”, а символы ∆ можно 

взять мышкой с панели 

“Greek” или набрать заглав-

ную D и нажать Ctrl+G. Со-

четание клавиш Ctrl+G пре-
вращает стоящую впереди 

букву в символ греческого 

алфавита. 
Переменным можно при-

сваивать любые имена 
(deltaH, Petya, 

Moya_peremennаya), но 

без пробелов. 

Задавать значения переменной можно не только численно. На-
пример, выберите на панели “Controls” инструмент “Slider” (рис. 6) 

и присвойте его переменной а. Теперь, 

передвигая движок, Вы можете изме-
нять значения а – согласитесь, весьма 
удобно и наглядно. Диапазон значений 

(по умолчанию от 0 до 100) можно ме-
нять, кликнув по движку правой кноп-

кой мыши и выбрав “Mathsoft Slider 

Control > Properties”. Попробуйте само-

стоятельно разобраться с другими ком-

понентами панели “Controls”. 

 
Рис. 5. Вычисление с параметрами 

 
Рис. 6. Инструмент 

Slider 
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2.4. Функции и графики 

– And what is the use of a book, – 

thought Alice, – without pictures or con-

versation? 

Lewis Carroll 

Уравнения с параметрами очень удобны, если требуется вычис-
лить лишь несколько значений функции. Но что если нам требуется 

вычислить значения функции в ста точках и построить график? Ко-

нечно, можно и постараться, сто раз подставляя значения аргумента 
и записывая значения функции на бумажку, но это – технология по-

запрошлого века. 
Пусть перед нами стоит задача вычислить энтальпию образова-

ния кальцита CaCO3 в диапазоне температур 300–1000 K. Здесь, 

очевидно, нам придется воспользоваться эмпирической зависимо-

стью теплоемкости от температуры ( ) 2
T

cbTaTC p ++= . 

Сначала запишите значение энтальпии при 298 К (∆Н298) и опре-
делите область значений независимой переменной Т (температура). 
В Mathcad это выглядит следующим образом: имя перемен-

ной,оператор присвоения,первое число диапазо-

на,запятая,второе число диапазона,многоточие,по-

следнее число диапазона. Многоточие вводится через сим-

вол точки с запятой “;”. Итак, в данном случае выражение для ввода 
Т будет следующим: 

T:300,325;1000 

Второе число диапазона вводится для определения шага измене-
ния переменной (в нашем случае 25 градусов). Если не вводить его, 

Mathcad будет по умолчанию считать с дискретизацией 1 (300, 301, 

302…). 

Теперь определите теплоемкость как функцию от температуры. 

Как бы Вы записали ее на бумаге? Правильно, Сp(T). И в Mathcad 

запись абсолютно аналогична (рис. 7).  

Теперь при вызове значений Ср через  
C.p=  

Mathcad возвращает ответ Сp=function, что позволяет Вам рас-
считать значение Сp для любой температуры Т. Так, например, для 

температуры 300 K рассчитывается Сp(300) = 82,274 (см. рис. 7).  



 18

Теперь определите энтальпию как функцию температуры. Чтобы 

не считать интеграл от теплоемкости вручную, предоставим это 

программе (см. рис. 7). Для вставки значка определенного интегра-
ла воспользуйтесь панелью “Calculus” либо нажмите символ “&” 

(Shift+7).  

Выбор метода численно-

го интегрирования по умол-

чанию возложен на про-

грамму. Тем не менее, клик-

нув правой кнопкой мышки 

по значку интеграла, можно 

выбрать в контекстном ме-
ню один из четырех имею-

щихся методов. 

Для построения графика 
можно либо выбрать в меню 

“Insert > Graph” пункт “X–Y 

Plot” либо нажать знак “@” 

(“Shift+2”). По оси абсцисс 
укажите имя независимой 

переменной (в данном слу-

чае Т), по оси ординат – имя 

функции (∆Н(T)), и любуй-

тесь получившимся графи-

ком (рис. 7). 

Также можете построить 

не зависимость ∆H(T) от Т, 

а, например, зависимость ln(∆H(T))) от 1/Т. Все, что для этого 

нужно, – поменять подписи по осям, Mathcad поймет, чего Вы хоти-

те. 
Если Вы предпочитаете строить графики в другой программе 

(Excel, Origin), то можете вызвать столбцы значений Т и ∆H(T) и 

скопировать их в буфер обмена. 
 

2.5. Трансцендентные уравнения  

Уравнения, содержащее трансцендентные функции (показатель-

ные, логарифмические, тригонометрические и обратные тригоно-

Рис. 7. Работа с функциями 
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метрические) от неизвестного (переменного), например, 
x

e
x 1

= , и 

системы подобных уравнений, весьма распространены в химиче-
ской термодинамике. В аналитическом виде подобные уравнения не 
решаются, а метод последовательных приближений очень трудо-

емок и не всегда обеспечивает приемлемую точность. Посмотрим, 

чем может в данном случае помочь Mathcad. 

Пусть требуется найти температуру, при которой давление паров 

воды составляет ровно 5,00 атм, не пренебрегая зависимостью эн-

тальпии и энтропии от температуры. 

Определите необходимые переменные: оценку ожидаемой тем-

пературы, теплоемкость, энтальпию и энтропию образования жид-

кой и твердой воды и запишите уравнение для давления пара, как 

это сделано на рис. 8. Здесь индекс “liq” относится к параметрам 

жидкой воды, индекс “gas” – газообразной. При первоначально вы-

бранной температуре 150 
оС давление насыщенного пара равно 4,4 

атм, значит, верное значение где-то близко.  

Можно подбирать Т, следя за изменением Р, а можно сделать 

умнее. Для решения уравнений и систем уравнений в Mathcad ис-
пользуется блок решения “given – find” (“дано – найти”). Запишите 
слово given, под ним введем наше условие: выражение для давле-
ния насыщенного пара, знак булева равенства ==== (подробнее о нем в 

разд. 2.3) и требуемое значение этого выражения, т. е. 5 (см. рис. 8). 

Теперь скомандуйте программе «найди решение относительно Т», 

для этого введите строчку  
find(T)= 

Полученный ответ и будет корнем уравнения. 

В данном случае для удобства автор ввел не  
find(T)= ,  

а  
find(T)-273.15= , 

чтобы получить ответ в градусах Цельсия (рис. 8). 

Для проверки устойчивости решения попробуйте подставить 

найденный ответ как оценочное значение Т выше блока given-
find. Если все в порядке, ответ должен измениться очень слабо. 
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Для большей 

точности вычисле-
ний можете ввести 

зависимость энталь-

пии и энтропии от 
температуры через 
теплоемкость, и да-
же эмпирические за-
висимости теплоем-

кости от температу-

ры. Эти полезные 
упражнения мы 

предлагаем Вам вы-

полнить самостоя-

тельно. 

Конечно, хоте-
лось бы использо-

вать найденный от-
вет в дальнейших 

вычислениях. Для этого вместо вызова ответа присвойте какой-

нибудь переменной (например, Т) значение T:=Find(T), и во всех 

нижеследующих вычислениях значение Т будет равно корню урав-

нения. 

Вместо функции find можно использовать также функции 

minerr, root, polyval, isolve. Подробные руководства 
по их использованию и примеры можно найти в Help к программе. 
Вызываете Help клавишей F1, открываете закладку «Указатель», 

находите пункт “equations, solving”, дважды кликаете по нему и в 

открывшемся окне выбираете раздел “Functions for Equation 

Solving”. Кстати, подобным путем можно разрешить 99 % всех воз-
никающих в ходе работы вопросов. 

Важно! Не забывайте правильно указывать программе пример-

ное значение переменной, относительно которой решаете уравне-
ние. Иногда уравнение имеет несколько дополнительных корней, 

противоречащих физическому смыслу. Программа не понимает, что 

температура не может быть отрицательной, значения энтальпии ле-
жат в интервале от килоджоулей до сотен килоджоулей, а концен-

трация 10
19

 моль/л относится к области ненаучной фантастики. Для 

 
Рис. 8. Пример решения трансцендент-

ного уравнения 



 21

того чтобы верно оценить примерное значение переменной, необ-

ходим человек с химическим образованием. То есть Вы. 

 

2.6. Системы уравнений 

– The question is, – said Alice, – 

whether you CAN make words mean so 

many different things. 

– The question is, – said Humpty 

Dumpty, – which is to be master that's 

all. 

Lewis Carroll 

Блок решения “given – find” применяется и для систем уравне-
ний. В этом случае ответ будет представляться в виде столбца зна-
чений и вызываться функцией find(x,y,x…) либо min-

err(x,y,x…), где в скобках через запятую перечисляются имена 
переменных, относительно которых надо решить систему (рис 9, а).  

 
Рис. 9. Решение системы уравнений 

 

Естественно, удобнее было бы создать переменные, которым бы 

мы присвоили значение ответа. Сделать это можно двумя путями: 

1) вставить матрицу из n строк и одного столбца (n – количество 

переменных) и присвоить ей значение minerr(x,y,z…)(рис 9, б), 

это делается с помощью раздела меню “Insert > Matrix” или сочета-
ния клавиш “Ctrl+M”;    
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2) присвоить новой переменной (например, а) значение 
a:=minerr(x,y,z…). Переменная а теперь станет столбцом от-
ветов, ее отдельные элементы можно вызывать через а0, а1 и так 

далее (рис 9, в).  

Важно! При определении элемента вектора или массива под-

строчный символ вводится через клавишу «[». Т.е. для вызова пер-

вого элемента вектора а нужно ввести 
a[0= 

Помните, нумерация в Mathcad начинается с нулевого элемента. 
 

2.7. Дифференциальные уравнения 

– Let me think: was I the same when 

I got up this morning? I almost think I 

can remember feeling a little different.  

Lewis Carroll 

Численное решение дифференциальных уравнений широко при-

меняется для быстрого и точного решения прямой кинетической за-
дачи: определения зависимости концентраций веществ от времени 

при заданных начальных концентрациях и скоростях. 

Для решения дифференциальных уравнений предусмотрены 

функции odesolve, rkadapt, rkfixed, bulstoer, а также некоторые дру-

гие. Подробную информацию о применимости каждого алгоритма 
можно найти в разделе Help под названием “differential equation 

solvers”. Остановимся пока на функции rkfixed. Данная функция ин-

тегрирует дифференциальные уравнения и их системы методом 

Рунге−Кутты четвертого порядка с постоянным (fixed) шагом и мо-

жет применяться для несложных кинетических схем. К сожалению, 

эта функция требует специфического ввода условия. 

Пусть имеется простейшая кинетическая схема  

CBA
kk
→→

21
. 

Известны значения констант скорости (k1=0,1 с-1
, k2=0,05 с-1

) и на-
чальных концентраций реагентов (A0=1 М, B0=0 М, C0=0 М). Требу-

ется найти, как будут изменяться концентрации этих веществ во 

времени в течение 100 секунд. 

По закону действующих масс зависимость концентраций реаген-

тов от времени можно записать в виде системы дифференциальных 

уравнений: 
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Сначала определите зна-
чения констант скорости 
k1=0,1 и k2=0,05, на-
чальный и конечный момен-

ты времени t0=0 и 

t1=100, а также число то-

чек N=1000 в интервале [t0, 

t1], в каждой из которых 

программа будет искать ре-
шение. Затем запишите век-

тор кинетических уравнений 

C(t,Y), где Y – массив 

концентраций, Y0, Y1 и 

Y2 – концентрации веществ 

А, В и С соответственно, а 
также вектор начальных значений C0. 

Важно! Не забывайте: каждый элемент массива вызывается че-
рез клавишу “[”.  

Теперь присвойте матрице решений S значение rkfixed 
(вектор уравнений,начальное значение независимой 
переменной,конечное значение независимой пере-

менной,число точек,начальные условия), как это показа-
но на рис.10.  

Если теперь вызвать S, вашему взору предстанет матрица из 1000 

строчек и 4 столбцов. Первый столбец – значения времени, второй, 

третий и четвертый – соответствующие значения концентраций. 

Отдельно столбцы можно вызвать, как это показано на рис.10, с по-

мощью верхнего индекса A:=S<1>. Верхний индекс ставится через 
“Ctrl+6” или кнопку “Matrix Column” панели “Matrix”.  

 
Рис. 10. Решение прямой кине-

тической задачи с помощью функ-

ции rkfixed 
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Осталось только построить график (рис. 10), и прямая кинетиче-
ская задача решена! 

Функция rkadapt требует такого же синтаксиса, но решает 
уравнения методом Рунге−Кутты с переменным шагом, анализируя 

скорость изменения решения. Функция bulstoer реализует метод 

Булирша−Штера (Bulirsch−Stoer Method) для так называемых жест-
ких систем (см. раздел 1.3). Подробнее ознакомиться со свойствами 

этих функций Вы можете в 

Help. 

Эти функции удобны в ра-
боте и при наличии некоторо-

го опыта затруднений с вво-

дом условия не возникает. Но 

для тех, кто предпочитает 
бóльшую наглядность, преду-

смотрена функция 

odesolve, работающая в 

блоке решения. 

Решим с ее помощью ту же 
задачу. Точно так же опреде-
лите вначале константы ско-

рости и временной интервал. 

Затем запишем блок решения 

с тремя дифференциальными 

уравнениями и граничными 

условиями, как это показано 

на рис. 11. Дифференциал 
dt

d
 

вводится через нажатие кла-
виш “Shift+/” либо из панели 

инструментов “Calculus”; также можно пользоваться значком про-

изводной “ ’ ” (вызывается нажатием “Ctrl+F7”). После того, как 

записаны все уравнения, вызовите функцию odesolve(вектор 
переменных,независимая переменная,конечное зна-

чение). Полученную зависимость концентрации от времени можно 

вывести на график либо вызвать в виде столбца значений для пере-
носа в другую программу. 

 
Рис. 11. Решение прямой кине-

тической задачи с помощью функ-

ции odesolve 
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Выбор метода численного решения также оставляется на усмот-
рение пользователя. Если кликнуть правой кнопкой мыши на функ-

цию odesolve, появится контекстное меню, в котором можно вы-

брать метод (с фиксированным и адаптирующимся шагом, а также 
stiff-метод для жестких систем). Для простых систем результат оди-

наков, но в случае сложной системы (автоколебания), возможно, 

Вам придется задуматься о методе интегрирования. Самый простой 

указатель ошибки метода при решении дифференциального уравне-
ния – это появление осцилляций с возрастающей амплитудой. 

 

2.8. Импорт и экспорт данных 

Когда Вы решаете контрольную, то берете необходимые числа 
из выданного задания, проводите расчеты на калькуляторе и пере-
писываете получившиеся ответы на бумагу. Точно так же в ходе ра-
боты часто требуется взять первичные экспериментальные данные 
из файла, обработать их и записать результат в другой файл. Если 

Вы снимаете с прибора пять-десять точек за эксперимент, то это 

еще полбеды - можно управиться вручную. Но что делать, если 

данные всю ночь записывались в файл АЦП (аналого-цифровой 

преобразователь) с получением таблицы из тысячи значений? По-

смотрим, что предусмотрено для импорта и экспорта данных в сре-
де Mathcad. 

Пусть есть 

эксперимен-

тально полу-

ченные значе-
ния давления 

насыщенного 

пара воды (в 

миллибарах) 

от температу-

ры (см. табли-

цу слева), а 
требуется пе-

ревести их в обратную темпера-
туру и логарифм давления. Вве-
дите значения из таблицы в Mi-

crosoft Excel и сохраните файл 

T, 
o
C P, mbar 

10.0 13.1 

70.0 306.7 

30.0 43.1 

50.0 122.2 

80.0 467.3 

40.0 73.8 

90.0 695.6 

60.0 196.3 

20.0 24.3 

 
Рис. 12. Импорт данных 



 26

под именем “Data.xls”. Теперь при работе в Mathcad 2001 войдите в 

меню “Insert > Component” и в появившемся окошке мастера выбе-
рите “Input Table” (в Mathcad 11 и 12 таблица вставляется через ме-
ню “Insert > Data > Table”). Присвойте таблице имя переменной, на-
пример, Data, и кликните по таблице правой кнопкой мышки (рис. 
12). В появившемся контекстном меню выберите “Import” и укажи-

те мастеру импорта наш файл “Data.xls”. Все, значения присвоены 

переменной DataIn, теперь она – матрица из двух столбцов, пер-

вый из которых – температура, второй – давление. Можно для кра-
соты отсортировать значения по возрастанию первого столбца 
функцией csort(имя матрицы,номер столбца). В данном 

случае это DataIn:=csort(DataIn,0) (см. рис. 12). Вы же не 
забыли, что нумерация начинается с нулевого столбца? 

Теперь пора обрабатывать данные, переведя температуру в об-

ратную температуру, а давление – в логарифм давления. Введите 
вектора-переменные 

DataOut<0>:1/(DataIn<0>+273) и  

DataOut<1>:ln(DataIn<1>) (см. рис. 12).  

У Вас есть матрица DataOut, 

столбцы которой содержат обра-
ботанные данные. Для их экспор-

та вызовите матрицу DataOut, 

дважды кликните на ней и в за-
кладке “Display options” выставь-

те параметр “Matrix display style” 

как “Table”. Теперь кликните по 

таблице правой кнопкой мышки и 

выберите пункт “Export” (рис. 13). 

В параметрах выходного файла 
поставьте “File Format” как, на-
пример, “Tab delimited text”, вы-

берите директорию для экспорта 
файла и столбцы или строки, которые надо экспортировать. Готово! 

Если Вы желаете импортировать данные из файла в режиме ре-
ального времени, то в меню выберите “Insert > Data > File Input” и в 

окошке мастера выберите файл, из которого собираетесь читать 

данные, и нужные строки или столбцы. Введите имя переменной, 

которая будет содержать данные из этого файла. Теперь всякий раз, 

Рис. 13. Экспорт данных 
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когда Вы заново проводите рас-
четы, нажимая F9, значения пе-
ременной заново считываются из 
указанного файла. 

Аналогично для экспорта дан-

ных в реальном времени выби-

райте пункт меню “Insert > Data > 

File Output”, в окошке мастера 
выбирайте формат файла, вводите его название и местонахождение, 
выбирайте экспортируемые строки или столбцы и нажимайте 
“Done”. Введите имя переменной, содержащей экспортируемые 
данные. Теперь каждый раз при повторении вычислений новые зна-
чения переменной DataOut будут автоматически записываться в 

указанный файл (рис. 14). 

Не спешите удалять полученные переменные, они понадобятся 

Вам в следующем разделе. 
 

2.9. Линейная регрессия 

– I didn't say there was nothing 

BETTER, – the King replied. – I said 

there was nothing LIKE it. 

Lewis Carroll 

После выполнения задания предыдущего раздела у Вас осталась 

переменная DataOut, содержащая обратную температуру и лога-
рифм давлений насыщенного пара воды. Этого достаточно, чтобы 

вычислить энтальпию и энтропию испарения воды. 

Как известно из химической термодинамики, 

( ) S
T

H
PR ∆+

∆
−=ln . 

Таким образом, из линейной аппроксимации данных в координа-
тах Клаузиуса (зависимость Rln(P) от (–1/T)) с помощью уравнения 

baxy +=  можно получить энтальпию и энтропию испарения при 

нормальной температуре кипения. 

Введите переменные ReciT:=–DataOut<0> (сокращение от re-

ciprocal temperature) и RlnP:=8.314*DataOut<1>. Для линейной 

регрессии (linear regression) используют функции 

Рис. 14. Импорт и экспорт 
в режиме реального времени 
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line(вектор_1,вектор_2) или mediafit(вектор_1, 

вектор_2). Определите столбец значений энтальпии и энтропии 

через функцию line(ReciT,RlnP), и Вам останется только 

сравнить полученный ответ с табличным (рис.15).  

Чтобы посмотреть своими глазами на достоверность ответа, от-
ложите экспериментальные данные и аппроксимирующую их ли-

нию на графике (см. рис. 15). 

Для большей наглядности дважды кликните по построенному 

графику и, перейдя на закладку “Traces”, установите следующие 
параметры для Trace 1: Symbol = о’s, Type = points. Теперь экспери-

ментальные данные представлены в виде точек.  

Полученные значения энтальпии и энтропии можно вывести в 

файл, как это описано в предыдущем разделе. А если Вы научитесь 

организовывать цик-

лы вычислений, то 

сможете заставить 

программу обсчиты-

вать по очереди де-
сятки и сотни файлов 

с экспериментальны-

ми данными и авто-

матически записывать 

получившиеся ре-
зультаты на жесткий 

диск, т. е. выполнять 

вместо Вас самую 

нудную часть работы. 

Это ли не сбывшаяся 

мечта, о которой было 

сказано во введении? 

 

2.10. Быстрое преобразование Фурье 

Поскольку мало у кого под рукой есть реальный сигнал спада 
свободной индукции ЯМР, попробуем обойтись своими силами: со-

ставить сложную периодическую функцию и применить к ней пре-
образование Фурье. Для применения БПФ требуется представить 

данные в виде векторов времени и значений функции от времени. 

Определите число счетных точек N=64 (число N должно быть це-

 
Рис. 15. Линейная регрессия 
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лой степенью двойки: 128, 256, 512 и т. п.), временной промежуток 

τ=10 и шаг изменения времени dt=τ/N. Теперь определите массив 

k=0..N и вектор времени tk=k*dt (рис. 16).  

Пусть частоты а, b и с 

равны 1, 2 и 3, а соответст-
вующие амплитуды 1, 2 и 1 

соответственно. Запишите 
вектор yk, как это показано 

на рис. 16. 

В среде Mathcad быстрое 
преобразование Фурье осу-

ществляют функции fft, и 

cfft, вектор ответов вызы-

вается командой, например, 

F:=fft(y). Сейчас Ваш 

вектор F является функцией 

от точки счета. Для его пе-
ревода в функцию от часто-

ты введите дополнительный 

вектор freqk:=(k+1)/τ и 

постройте для наглядности 

график (рис. 17). Получи-

лись три пика при частотах, 

близких к 1, 2 и 3 и с соот-
ношением амплитуд 1:2:1. 

Попробуйте сами поэкс-
периментировать со значе-
ниями N и различными 

функциями для быстрого 

преобразования Фурье. 
Функция cfft допускает ис-
пользование произвольного 

значения N. 

 
Рис. 16. Сумма трех синусоид 

 
Рис. 17. Быстрое преобразование 
Фурье 
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3. ОБЩИЕ ПРИНЦИПЫ РАБОТЫ С ПАКЕТОМ MICRO-

CAL ORIGIN 

Предназначенная для визуализации данных программа Microcal 

Origin заметно превосходит по качеству графики и удобству ис-
пользования такие широко распространенные пакеты, как Microsoft 

Excel, Mathematica, MathCAD, Maple, Matlab. Она позволяет созда-
вать профессиональные презентации и графические отчеты, при-

годные как для издания на бумаге (например, в журналах, книгах), 

так и для публикации в электронном виде (скажем, размещения в 

Интернете). Несмотря на огромные возможности этой программы, 

она мало кому известна в России, и литература по ее применению 

практически отсутствует.  
 

3.1. Построение графика 

The best way to explain it is to do it. 

Lewis Carroll 

Интерфейс программы Origin довольно прост. При ее открытии 

Вы видите следующее (рис. 18): 

 
Рис. 18. Главное окно Origin 
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Внутри основного окна располагается Worksheet (лист данных) с 
именем “Data1”, в который можно вводить свои значения. Колонки 

подписаны по умолчанию A(X) и B(Y). Введите таблицу экспери-

ментальных значений A и B, как это показано на рис. 18. В рассмат-
риваемом примере А – температура в градусах Цельсия, В – давле-
ние аммиака над комплексом BaCl2×8NH3. 

Важно! Конечно, значения необязательно вводить вручную, их 

можно импортировать из готового файла (подробнее см. разд. 3.5). 

Если Вы желаете присвоить колонке A какое-нибудь имя, на-
пример, “Temperature”, дважды кликните на названии колонки и в 

появившемся окошке в поле “Column Label” введите “ Temperature”. 

На вопрос “Do you wish to automatically display the column label?” 

отвечайте “Yes”, и под названием колонки “A(X)” появится подпись 

“Temperature”. Аналогично присвойте колонке B(Y) имя “Pressure”. 

Добавлять колонки можно через меню “Column > Add New Col-

umns…” или Ctrl+D. 

Для построения графика выделите мышкой обе колонки (просто 

проведите по названиям колонок, удерживая нажатой левую кнопку 

мышки), и в меню “Plot” выберите “Line+Symbol”. Ваш первый гра-
фик готов. 

Если столбцов несколько, то выделить необходимые для по-

строения графика можно мышкой при нажатой клавише «Ctrl». 

 

3.2. Редактирование графика 

I know who I WAS when I got up 

this morning, but I think I must have 

been changed several times since then. 

Lewis Carroll 

Графики Origin красивы даже без дополнительного редактирова-
ния, но, как известно, предела совершенству нет. 

Большинство операций над графиком начинается с двойного 

щелчка мышкой по объекту. Дважды щелкнув по легенде, Вы попа-
дете в окно свойств легенды (“Text Control”), где можете изменить 

границы, заливку, шрифт, размер, цвет, начертание надписи, и, ко-

нечно, текст легенды. Язык ввода Origin довольно своеобразен, но к 

нему быстро привыкаешь. Так, в поле легенды тэг \L(1) отобра-
жается в виде символа, соответствующего первой линии графика, а 
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тэг %(1) – в виде подписи соответствующей колонки листа данных. 

Попробуйте, например, заменить %(1) на слово “Давление”. 

Важно! Если вместо букв кириллицы отображаются «крокозяб-

лики», выделите написанное и выберите кириллический шрифт 
(Arial Cyr, Times New Roman Cyr etc.). 

Поставьте параметр “Back-

ground” равным “Shadow”, раз-
мер шрифта 36 пунктов, начер-

тание “Bold” и “Italic”. Должен 

получиться результат, показан-

ный на рис. 19. 

Дважды кликнув на надписи “X Axis Title” либо “Y Axis Title”, 

попадаете в аналогичное окошко, где можете изменить подписи 

осей X и Y. Поставьте по оси Х подпись «Температура, оС», а по оси 

Y – «Давление, атм», размер подписей установите 36 пунктов. 

Верхний символ градуса “o
” в Origin вводится через тэг \+(o). 

Двойной клик по линии графика вызывает окно свойств графика 
(“Plot Details”), где можете менять тип графика (линия, символы, 

линия + символы), цвет и толщину линии и символов, а также тип 

соединения точек. По умолчанию толщина линии 0,5 пункта, что 

слишком мало для визуализации. Увеличьте этот параметр до 5 

пунктов, а размер символа до 12 пунктов. 

Двойной щелчок по оси вызывает окно свойств оси с семью за-
кладками. Обратите внимание, что слева в окне свойств оси Вы мо-

жете выбирать ось, свойства которой хотите редактировать. 

Закладка “Scale” определяет шкалу оси (минимальное и макси-

мальное значения, период) и тип шкалы. К Вашим услугам любые 
шкалы – от линейной и логарифмической до вероятностной и даже 
переводящей градусы Цельсия в обратные градусы Кельвина. Уста-
новите по оси Х шкалу “Offset reciprocal” от 20 до 60 и по Y шкалу 

“Log 10” от 1 до 11. 

На закладке “Tick Labels” можно определить параметры чисел на 
шкале: размер, шрифт и т. д. Установите размер шрифта 26, по-

ставьте флажок “Apply to Point (This Layer)” и нажмите “Apply”. По 

обеим осям размер чисел стал одинаковым и равным 26 пунктам. 

Закладка “Title and Format” позволяет менять параметры осей: 

цвет, толщину, текст подписи, а также наличие или отсутствие осей 

справа и сверху. Увеличьте толщину обеих осей до 3 пунктов. 

Рис. 19. Легенда графика 
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Закладка “Grid Lines” определяет параметры линий сетки. Уста-
новите по вертикальной оси флажок напротив “Major Grid”, а по го-

ризонтальной – напротив “Minor Grid”. 

На закладке “Minor Tick Labels” установите по оси Y флажок 

“Enable Minor Labels”. Теперь появятся подписи у промежуточных 

делений шкалы. 

Все, можно нажимать “OK”! Должен получиться результат, по-

хожий на рис. 20. Согласитесь, по сравнению с Origin графика Excel 

или Mathcad кажется несколько архаичной. 

Теперь в меню “Edit” выберите “Copy Page”, и можете вставлять 

график в документ Microsoft Word или PowerPoint. Именно так и 

был сделан рис. 20.  

 
Если Вы уже после вставки готового графика в документ обна-

ружите, что давление выражается не в атмосферах, а в кгс/см2
, не-

обязательно открывать снова файл Origin, редактировать график и 

переносить его в Word. Достаточно дважды кликнуть мышкой по 

графику прямо в документе Word. Если на компьютере установлена 
программа Origin, то она автоматически будет вызвана, и Вы смо-

жете изменить график прямо в своем документе.  
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Рис. 20. График, построенный в Origin 
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3.3. Добавление кривых на график. Слои графика 

Сейчас у Вас имеется график зависимости давления от темпера-
туры для комплекса BaCl2×8NH3. Внесем на тот же график зависи-

мость теплоемкости BaCl2 от температуры. 

В том же самом файле через меню 

“Window” перейдите на лист “Data1” и 

добавьте еще две колонки через меню 

“Column > Add New Columns…” 

вставьте еще две колонки, озаглавьте 
их “Temperature” и “Specific heat” и 

введите в них следующие значения 

(см. таблицу справа). Для того чтобы получить зависимость тепло-

емкости от температуры, кликните правой кнопкой мышки по ко-

лонке C и в контекстном меню выберите “Set As > X”. Теперь ко-

лонка С содержит значения переменной X2, а колонка D – завися-

щей от нее переменной Y2 (рис. 21). 

Теперь перейдите в окно графика. Нужно добавить на график 

еще и зависимость теп-

лоемкости от темпера-
туры, но как это сде-
лать? По оси Y уже от-
ложено давление, теп-

лоемкость имеет совсем 

другую размерность, и 

откладывать ее на ту же 
шкалу нельзя. Значит, 
надо создать еще одну 

шкалу Y. 

Те, кто работал в Adobe 

Photoshop, знают, каким 

мощным инструментом 

являются «Слои». Но-

вый слой – это рисунок или фрагмент рисунка, положенный поверх 

предыдущего и редактируемый независимо от него. Этот инстру-

мент предусмотрен и в Microcal Origin. 

В меню “Edit” выберите “New Layer(Axes) > (Linked) Right Y”. 

У Вас появится еще один слой, связанный с предыдущим шкалой 

по X, но с другими значениями Y. В верхнем левом углу графика 

Temperature Specific heat 

20 75.223 

30 75.363 

40 75.503 

50 75.642 

60 75.782 

 
Рис. 21. Контекстное меню колонки 
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рядом с серой кнопкой с цифрой 1 появится такая же с цифрой 2. 

Нажимая на них мышкой один раз, можно выбирать слой для ре-
дактирования 

 

 
 

Рис. 22. Окно добавления кривых на график 

 

Двойной клик на кнопке с цифрой 2 вызовет окно добавления 

кривых на слой 2 (рис. 22). В поле “Available data” расположен спи-

сок данных для построения графика, в поле “Layer Content” –список 

имеющихся на графике кривых. Выберите “data1_d”, затем нажмите 
на кнопку со стрелкой, как это показано на рис. 22. Теперь кривая 

перенесена на график. 
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Рис. 23. График с двумя слоями 
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Осталось подкорректировать шкалы, чтобы кривые не налезали 

одна на другую, сделать подпись по правой оси Y и поставить 

стрелки, указывающие, с какой шкалы считывать данные для кри-

вых. Получившийся результат должен выглядеть как на рис. 23. Об-

ратите внимание, что при перенесении графиков в документ метки 

слоев исчезают. 
 

3.4. Импорт и обработка экспериментальных данных 

She took a ribbon out of her pocket, 

marked in inches, and began measuring 

the ground, and sticking little pegs in 

here and there. 

Lewis Carroll 

Программа Microcal Origin позволяет аппроксимировать полу-

ченные экспериментальные данные любой нужной Вам функцией, а 
также и многими ненужными. В предыдущем примере для второго 

слоя выберите меню “Analysis > Fit Polynomial”. Задайте порядок 

полинома (второй), число точек, максимальное и минимальное зна-
чение Х и поставьте галочку напротив пункта “Show Formula on 

Graph?” На графике появится кривая аппроксимации данных и 

уравнение этой кривой, а поверх окна графика появится окно “Re-

sults Log”, в котором находятся результаты аппроксимации: коэф-

фициенты полинома, среднеквадратичное отклонение и т. п. Анало-

гично выполняется и линейная регрессия, только в меню “Analysis” 

надо выбрать “Fit Linear”. 

Важно! Если на одном слое располагается несколько кривых, то 

выделить аппроксимируемую кривую можно, кликнув по ней пра-
вой кнопкой и выбрав “Set As Active”. 

В общем случае можно использовать пункт “Non-linear Curve 

Fit…”, при этом появляется окошко выбора и редактирования 

функции. Оно может быть представлено как в простом (Basic), так и 

в расширенном (Advanced) виде.  
В памяти Origin около сотни различных функций, относящихся к 

самым разным областям науки и техники. Если же Вам нужна но-

вая, Вы всегда можете ее создать. Для этого необходимо нажать 

кнопку “New…” и ввести свою функцию. Не забудьте правильно 

указать число параметров и тип функции (Expression или Y-Script), 



 37

а также верно задать оценочные значения параметров. После этого 

запускайте итерационные вычисления. 

При аппроксимации данных на слое 1 (давление аммиака над 

комплексом) функцией  
y=exp(-(P1-P2*(x+273))/(8.314*(x+273))) 

у автора получились значения параметров P1 = 36,6 кДж/моль, P2 = 

131,1 Дж/К*моль. А у Вас? 

Если требуется аппроксимация только части кривой, нажмите на 
панели “Tools” кнопку “Data Selector” (рис. 24) и с его помощью 

выделите нужный диапазон. 

На той же панели находятся кнопки “Screen Reader” и “Data 

Reader”, выполненные в виде прицела (рис. 24). Эти инструменты 

очень удобны для вы-

числения координат то-

чек графика. Для повы-

шения точности реко-

мендуем сначала увели-

чить ту часть графика, в 

которой Вы работаете 
инструментом “Enlarger” (Лупа). 

Origin также позволяет интерполировать или экстраполировать 

функцию. В меню “Analysis” выберите “Interpolate / Еxtrapolate”, 

укажите максимальное и минимальное значения Х и число точек в 

выбранном промежутке. Функция используется, например, если у 

Вас есть 500 экспериментальных точек, а для быстрого преобразо-

вания Фурье их требуется 512 или 1024. 

 

3.5. Импорт данных. Работа с данными 

Для импорта данных в Worksheet предусмотрено меню “File > 

Import…”. Для импорта данных из текстового файла (*.txt, *.dat, 

*csv) выбирайте пункт “Single ASCII”. В отличие от Excel, оши-

бающейся с форматом данных и импортирующей число 1,01 как “01 

января”, Origin не допускает подобных ошибок. 

Для обработки данных (например, в колонке B имеются значе-
ния концентрации, а нужен логарифм концентрации) создайте ря-

дом еще одну колонку, кликнув правой кнопкой мышки на ее загла-
вие, выберите “Set Column Values As…” и введите формулу 

Рис. 24. Панель Tools 
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ln(col(B)). Теперь в колонке С будет содержаться логарифм 

значений колонки В. 

Конечно же, такой метод не очень удобен, электронные таблицы 

Excel куда привычнее. Для удобства пользователей в Origin послед-

них версий предусмотрена и такая возможность: наряду с обычны-

ми окнами Worksheet и 

Graph появилось окно 

Book, представляющее 
собой книгу Microsoft 

Excel. Для его вставки 

выберите в меню “File > 

New” пункт “Excel” или 

нажмите соответствую-

щую кнопку на панели 

“Standard” (рис. 25).  

Вычислительная 

мощь и привычный интерфейс таблиц Excel вкупе с визуализацией 

Origin позволяют выполнить любые необходимые расчеты и пред-

ставить их в приятном для глаза коллег виде. 
 

 
Рис. 25. Вставка книги Excel 
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ЗАКЛЮЧЕНИЕ 

 

Представленные в данном пособии материалы ни в коем случае 
не претендуют на полноту описания программ Mathsoft Mathcad и 

Microcal Origin. Здесь дано описание лишь самых основных функ-

ций, применяемых научными сотрудниками чаще всего.  

Автор надеется, что этим пособием воспользуются не только хи-

мики, но и все, кому приходится сталкиваться с обработкой и ви-

зуализацией экспериментальных данных.  

И напоследок еще одна рекомендация. Если у Microcal Origin по 

части визуализации на данный момент нет конкурентов, то для ма-
тематических расчетов созданы десятки (а может, и сотни) разнооб-

разных пакетов. Помните, у любой программы есть свои достоинст-
ва и недостатки. Mathworks Matlab быстрее считает, позволяет под-

ключать многочисленные Toolbox и даже самому дописывать 

функции. Ядру Waterloo Maple нет равных по части символьных 

вычислений. Свои поклонники есть и у пакетов Wolfram Mathe-

matica, Macsyma, Гусеница, а кто-то до сих пор пишет на старом 

добром Fortran. Mathsoft Mathcad рекомендуется как универсальная 

программа с понятным и удобным интерфейсом, которую можно 

освоить в сравнительно короткий срок. Не пытайтесь параллельно 

изучать что-то еще. Если же Вам не хватит возможностей Mathcad, 

сначала дотошно выясните возможности существующих программ, 

и лишь после этого принимайтесь за их изучение. 
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ПРИЛОЖЕНИЕ. 

ОСНОВНЫЕ «ГОРЯЧИЕ КЛАВИШИ» MathСad 

Сочетание клавиш Действие 

 

\ Квадратный корень 

; Определение диапазона 

‘ Скобки 

Shift+1 Факториал 

Shift+2 График в декартовых координатах 

Shift+3 Произведение  

Shift+4 Сумма 

Shift+6 Возведение в степень 

Shift+7 Определенный интеграл 

Shift+\ Модуль числа 

Shift+\ Дифференциал 

~ (Shift+`) Оператор глобального присвоения 

Ctrl+= Булев оператор равенства 

Ctrl+\ Корень произвольной степени 

Ctrl+. Символьные вычисления 

Ctrl+F7 Значок производной 

Ctrl+I Неопределенный интеграл 

Ctrl+M Матрица 

Ctrl+G Превращение стоящей впереди буквы в 

символ греческого алфавита 

Ctrl+7 График в полярных координатах 

Ctrl+1 Транспонирование матрицы 

Ctrl+2 Трехмерный график поверхности 

Ctrl+3 Оператор «не равно» 

Ctrl+4 Сумма 

Ctrl+5 Контурный график 

Ctrl+6 Выбор столбца матрицы 

Ctrl+7 График в полярных координатах 

Ctrl+8 Крестик умножения 

Ctrl+9 Оператор «меньше либо равно» 

Ctrl+0 Оператор «больше либо равно» 

Ctrl+Shift+P Число «пи» 
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